




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©July 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
II
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 3.42A (65 Watts)/18.5V, 3.5A (65 Watts) minimum AC/DC Adapter for Model A and B comput-
ers, OR 19V, 4.74A (90 Watts) minimum AC/DC Adapter for Model C computers.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
III



Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
IV
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VI
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
VIII
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
X
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
XII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Function/Hot 
Keys, Quick Buttons, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth and PC Camera, modules (some of 

which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the VIA Video driver controls.
• Appendix C Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
• Appendix E Information on the Windows XP OS.
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Model Differences
This notebook series includes three different model types. The models differ as indicated in the table below.

Table 1 - 1 - Model Differences

Feature Model A Model B Model C

Video Adapter VIA Integrated Video System
(Internal On Chip)

NVIDIA Discrete Video System
(External On Board)

Windows Vista Version 
Supported

Windows Vista Home Basic Edition 
(32-bit)

Windows Vista (32-bit) Home Basic Edition/Home Premium Edition
Windows Vista (32-bit) Business Edition/Enterprise Edition/Ultimate Edition

 Fingerprint Reader No Optional

Zoom & Audio Record 
Buttons & Indicators Yes No

Power Supply Adapter 65W (DC Output 19V, 3.42A or 18.5V, 3.5A) 90W (DC Output 19V, 4.74A)

Display Supported

 See Table 2 - 2, on page 2 - 10

15.4" WXGA
17" WXGA

17.1" WSXGA+
17.1" WUXGA
1 - 2 Overview
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the remainder of the User’s Manual. You may also find the notes marked with a  of interest to
you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide chapter should be enough to get
you up and running. Eventually you should try to look through all the documentation
(more detailed descriptions of the functions, setup and system controls are covered
in the remainder of the User’s Manual), but do not worry if you do not understand
everything the first time. Keep this manual nearby and refer to it to learn as you go.
You may find it useful to refer to the notes marked with a  as indicated in the mar-
gin. For a more detailed description of any of the interface ports and jacks see “In-
terface (Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
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Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and util-
ities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
1 - 4 Overview
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Table 1 - 2 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page E - 1.

Operating Systems Supported
Note

Model A Computers Model B & C Computers

*Windows XP Home or Professional Editions In order to run Windows
Vista  without limitations or
decreased performance,
your computer requires a
minimum 1GB of system
memory (RAM).

Windows Vista (32-bit) Home Basic Edition

Windows Vista (32-bit) Home Premium Edition

Windows Vista (32-bit)
Business/Enterprise/Ultimate Editions
Overview 1 - 5
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED indicators show the power and battery status of the computer.

Figure 1 - 1 - AC/DC Adapter In

Shutdown

Note that you should always shut your computer down by choosing
the Shut Down command from the Lock Button Menu in Win-
dows Vista. This will help prevent hard disk or system problems.
1 - 6 System Startup
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System Map: LCD Panel Open Models A & B

Figure 1 - 2 - Top View with LCD Panel Open Models A & B

2

6

1

8
9

4

1. Optional Built-In PC Camera
2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. Hot Key Buttons (Record 

Audio & PC Camera Zoom)
7. Keyboard
8. TouchPad and Buttons
9. Built-In Microphone
10. LED Indicators
11. Fingerprint Reader 

(Optional for Model B 
Computers only)

7

3 3

5

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator
icon to see if the modules
are powered on or not (see
Table , on page 1 - 9/
Table 1 - 5, on page 1 -
12).

10

10

11
System Map: LCD Panel Open Models A & B 1 - 7
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System Map: LCD Panel Open Model C

Figure 1 - 3 - Top View with LCD Panel Open Model C

2

5

1

7

8

4

1. Optional Built-In PC Camera
2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. Keyboard
7. TouchPad and Buttons
8. Built-In Microphone
9. LED Indicators
10. Fingerprint Reader 

(Optional)

6

9

3 35

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator
icon to see if the modules
are powered on or not (see
Table , on page 1 - 9/
Table 1 - 5, on page 1 -
12).

4

5

10

9

1 - 8 System Map: LCD Panel Open Model C
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LED Indicators
The LED indicators display helpful information about the current status of the computer.

Table 1 - 3 - LED Indicators

Icon Color Description

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated

Green The Computer is On

Blinking Green The Computer is in Sleep Mode

Orange The AC/DC Adapter is Plugged In & the Computer is Powered Off

Orange The AC/DC Adapter is Plugged In & the Battery is Charging

Blinking Orange The Battery has Reached Critically Low Power Status

Green The Battery is Fully Charged

Green Hard Disk Activity

Green The WLAN/Bluetooth Module(s) is/are Powered On
LED Indicators 1 - 9
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Hot Key Buttons
These buttons give instant access to the functions indicated in the table below. The Application  and zoom 
hot key functions depend on whether or not a PC Camera module is installed. Note that Model C does not sup-
port the Audio Record and Zoom (or Application Quick Buttons 2 & 3) hot key buttons.

Table 1 - 4 - Hot Key Buttons

Hot Key Button Function

PC Camera Installed Activate the BisonCap program/Take Still Picture (See Page 7 - 17)

PC Camera Not Installed Activate Application Quick Button 1 (See Page 2 - 11)

 Activate the Default Internet Program

Activate the Default E-Mail Browser

Audio Record Start/Stop (See Page 2 - 12)

PC Camera Installed  Camera Zoom-In (See Page 7 - 17)

PC Camera Not Installed Activate Application Quick Button 2 (See Page 2 - 11)

PC Camera Installed Camera Zoom-Out (See Page 7 - 17)

PC Camera Not Installed Activate Application Quick Button 3 (See Page 2 - 11)
1 - 10 Hot Key Buttons
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Keyboard
The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to
change operational features instantly (see Figure 1 - 4). Note that Model C computers have a Numeric keypad
to the right of the main keyboard.

Figure 1 - 4 - Keyboards

Fn Key

Function Keys
NumLk & 
ScrLk Keys

Numeric 
Keypad

Fn Key

Function Keys NumLk/ 
ScrLk Key

Numeric 
Keypad

Model A & B Computers Model C Computers

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system
will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may
not work.
Keyboard 1 - 11
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Function Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down.

Table 1 - 5 - Function Keys

Key Function Key Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F8 Decrease LCD Brightness

Fn + F1 TouchPad Toggle Fn + F9 Increase LCD Brightness

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on)

Fn + F10 PC Camera Module Power Toggle

Fn + F3 Mute Toggle Fn + F11 Wireless LAN Module Power Toggle

Fn + F4 Sleep Toggle Fn + F12 Bluetooth Module Power Toggle

Fn + F5 Decrease Audio Volume Fn + NumLk Number Lock Toggle (Models A & B)

Fn + F6 Increase Audio Volume Fn + ScrLk Scroll Lock Toggle

Fn + F7 Display Toggle NumLk Number Lock Toggle (Model C)

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using
the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 12 Function Keys
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System Map: Front & Rear Views

Figure 1 - 5 - Front & Rear Views

1

2 4
3

Models A & B

Models A & B

Model C5 5
1

1. LED Indicators
2. 1 * USB Port
3. DC-In Jack
4. Battery
5. LCD Latches 

(Model C Only)

Model C

2
3

1

System Map: Front & Rear Views 1 - 13
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System Map: Left View

1 52 4 63 7

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager
(Hardware and Sound), then click the + next to DVD/CD-
ROM drives. Double-click on the DVD-ROM device to bring
up the Properties dialogue box, and select the DVD Region
(tab) to bring up the control panel to allow you to adjust the
regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-depen-
dent. You can select your module’s region code 5 times. The
fifth selection is permanent. This cannot be altered even if
you change your operating system or you use the module in
another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an
unexpected power interruption) you may push the end
of a straightened paper clip into the emergency eject
hole. Do not use a sharpened pencil or similar object
that may break and become lodged in the hole. 

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the sys-
tem is accessing it. This may cause the system to
“crash”.

Figure 1 - 6 - Left View

1. Security Lock Slot
2. Optical Device Drive Bay 

(see page 2 - 3)
3. RJ-11 Modem Jack
4. S/PDIF-Out Jack
5. Microphone-In Jack
6. Headphone-Out Jack
7. Recording Line-In Jack (see page A - 2)

1 2 54 63 7

Models A & B

Model C
1 - 14 System Map: Left View
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System Map: Right View 

1
432

ExpressCard Slot

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)
MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

3
5

Figure 1 - 7 - Right View
1. ExpressCard Slot 

(see page 2 - 7)
2. 7-in-1 Card Reader
3. 2 * USB 2.0 Ports
4. RJ-45 LAN Jack
5. External Monitor Port1

432 3
5

Models A & B

Model C
System Map: Right View 1 - 15
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System Map: Bottom View 

2

3

CPU

The CPU is not a user ser-
viceable part. Opening this
compartment, or accessing
the CPU in any way, may vi-
olate your warranty.

Overheating

To prevent your computer
from overheating make sure
nothing blocks any Vent/Fan
Intake while the computer is
in use.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery
at least once every 30 days or after about 20 partial discharges. See “” on page 3 - 9 for full instructions.

4

1

Figure 1 - 8 - Bottom View
1. Vent/Fan Intake/Outlet
2. Battery
3. Hard Disk Bay Cover
4. CPU/RAM Bay Cover

1

1
1

3

4

2

Models A & B

Model C
1 - 16 System Map: Bottom View
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Classic View 
Windows Vista Start Menu & Control Panel 1 - 17
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Video Features
This computer features two different (either VIA for Model A or NVIDIA for Models B & C) video options.
You will be provided with an appropriate driver on the Device Drivers & Utilities + User’s Manual CD-ROM.

You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista. For further information see “VIA Video Driver Controls” on page B - 1 (Mod-
el A computers) OR “NVIDIA Video Driver Controls” on page C - 1 (Model B & C computers).

To access Display Settings in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 10 on page 1 - 19).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 19).
5. Click Advanced Settings (button)  (Figure 1 - 10 on page 1 - 19) to bring up the Advanced Settings tabs.
6. For NVIDIA computers (Models B & C); click GeForce..... (tab), and then click Start the NVIDIA Control Panel 

 (Figure 1 - 10 on page 1 - 19) to make any video adjustments
OR

7. Right-click the desktop and click Personalize, and then click Display Settings and adjust as above.

1
2

3

4

1 - 18 Video Features
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Figure 1 - 10 - Display Settings

1 2

3

1 2

3

1 2

3

4

Video Features 1 - 19
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 17) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “” on page 3 - 9.

Figure 1 - 11 - Power Options

Note: Sleep is the default power saving state in Windows Vista
1 - 20 Power Options
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Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 7-in-1 Card Reader
• ExpressCard Slot
• TouchPad and Buttons/Mouse
• Function Keys/Hot Keys
• Application Quick Buttons
• Recording Audio
• Audio Features
• Adding a Printer

Model C Computers

Note that Model C com-
puters do not support
the audio record or cam-
era zoom hot keys func-
tions.

Model C computers do
not display the visual in-
dicators illustrated in
Table 2 - 2, on page 2 -
10.

You may configure the
 Application Hot Key

(for one application) as
outlined in “Application
Quick Buttons” on
page 2 - 11.
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page D - 3) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location

Models A & B Model C
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page D - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Security Menu” on page 5 - 9).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 14).

 Figure 2 - 2
Optical Device

1

2

3

1
2 3
Optical (CD/DVD) Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
Optical (CD/DVD) Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 4
Right View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

1

Models A & B

Model C
2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard 
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

 Figure 2 - 5
Express Card Slots
ExpressCard Slot 2 - 7
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
can configure the functions by double-clicking the TouchPad driver icon  on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 6
Mouse Properties
2 - 8 TouchPad and Buttons/Mouse
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Function Keys/Hot Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn
key is held down. 

Model A & B Computers
In addition to the basic function key combinations visual indicators are available (for
Models A & B Only) when the hot key driver is installed (see “Hot Key Utility
(Model A & B Computers)” on page 4 - 6). After installing the driver an icon  will
appear in the taskbar.

The hot key buttons give quick access to the default internet browser  and e-mail
program . The PC Camera buttons    can be used to run the BisonCap ap-
plication, to take still pictures and to zoom the camera in/out (see “PC Camera Hot
Key Buttons” on page 7 - 17) if a PC Camera module is installed (this does not apply
to Model C). If you do not have a PC Camera module installed see “Application
Quick Buttons” on page 2 - 11 for details.

Model C Computers
There are no visual indicators available for Model C computers, however you can
configure an application (Application 1) to open when the hot key  button is
pressed (see “Application Quick Buttons” on page  A - 11).

Hot Key Program

The hot key visual
indicators will only be
displayed (and the audio
record function will only
run) if the program is
running (i.e. the icon  is
displayed in the taskbar).
If you have closed the
program you can run it
again from C:\Program
Files\HotKey_Driver\Ho
tKeyDriver.exe.
Function Keys/Hot Keys 2 - 9
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Table 2 - 2 - Function Keys/Hot-Key Buttons & Visual Indicators

Keys/Button Function Keys/Button Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F10 PC Camera 
Power Toggle

Fn + F1 TouchPad 
Toggle Fn + F11 WLAN Module 

Power Toggle

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F12

Bluetooth 
Module Power 

Toggle

Fn + F3 Mute Toggle Fn + NumLk Number Lock Toggle (Model A & B)

Fn + F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle

Fn + F5/F6
Volume 

Decrease/
Increase

NumLk Number Lock Toggle (Model C)

Fn + F7 Display Toggle Audio Record 
Start/Stop

Fn + F8/F9
Brightness 
Decrease/
Increase

Activate BisonCap Program/ 
Take Still Picture

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 

Models 
A & B Only 
2 - 10 Function Keys/Hot Keys
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Application Quick Buttons
Note that the application quick button utility is designed to allow use of the hot key
buttons in absence of the optional PC Camera (the quick button utility will only
appear if no PC Camera is installed). You will need to install the Quick Button
Utility (see page 4 - 6) to enable the functions.

The quick buttons give instant access to user-defined applications, with one quick
button press. To configure a program to open when the buttons  (see Table ,
on page 1 - 10) are pressed, follow the instructions below. The quick buttons will
function as long as the program is running (the icon  will appear in the taskbar).
If the program is not running you will need to restart the computer.

1. Press a button  or right-click the icon  in the taskbar.
2. Select Setup from the menu, scroll to AP1/2/3 (or just Application 1 for Model C 

computers) and select Custom.
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the required application.exe (see sidebar) exists.
5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop and click Prop-
erties. Click the short-
cut (tab) and see where
the executable file is lo-
cated by clicking the
Open File Location
(button).

 Figure 2 - 7
Quick Button 
Configuration 

Screens
Application Quick Buttons 2 - 11
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 Recording Audio
(Models A & B only)
The  audio record hot key button allows you to record audio from either the built-
in microphone, or from a microphone connected to the microphone-in jack. To
record on the computer, setup the audio recording options in Windows as follows
(see Figure 2 - 8 on page 2 - 13).

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (VIA High Definition Audio) and make sure the item is not 

disabled (if you wish to record from the internal microphone make sure that the 
Front Mic is not disabled).

5. Double-click Microphone/Front Mic (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone/Front Mic slider to the level 

required.
7. Click OK and close the control panels.
8. Press the audio record button  to begin the recording process (the record icon 

 will flash in the top left of the screen).
9. Press the  audio record button again to stop the recording process (the record 

icon will disappear from the top left of the screen).
10. The recorded audio file (in .wav format) will appear in the wav folder in the Users 

folder (C:\Users\wav).
11. Double-click the file to playback the recorded audio.

Model C Computers

Note that Model C com-
puters do not support
the audio record or cam-
era zoom hot keys func-
tions.

Model C computers do
not display the visual in-
dicators illustrated in
Table 2 - 2, on page 2 -
10.

You may configure the
 Application Hot Key

(for one application) as
outlined in “Application
Quick Buttons” on
page 2 - 11.
2 - 12 Recording Audio
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Right-click

Figure 2 - 8
Audio Setup for 

Recording 
(Windows Vista)
Recording Audio 2 - 13
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the VIA Audio Deck  icon in the taskbar, or on the
desktop  (this will bring up the VIA Audio Deck menu). The volume may also be
adjusted by means of the Fn + F5/F6 key combination.

Click any of the buttons (e.g. ) on the left to expand the audio menu selections. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 9
VIA Audio Deck 
Configuration 

Menus
2 - 14 Audio Features
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 15
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “” on page 3 - 9.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down). Use Power Op-
tions (Hardware and Sound menu) control panel in Windows Vista to configure
this feature.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5



Power Management

3

Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Lock Button Menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

Resolution Error

If you are experiencing
screen resolution prob-
lems/screen flickering after
resuming from Sleep in
Windows Vista (for NVID-
IA Models B & C only) see
page 8 - 13.

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key but-
ton when it is pressed for less than 4 seconds (pressing and holding the power button for
longer than this will shut the computer down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Charging on Model B & C Computers
Note that Model B & C computers under a heavy load (e.g. using applications which
require a lot of video processing), while running on battery power, will take time (3
to 20 minutes before charging begins) to recharge the battery when plugged in to the
AC/DC adapter. This is due to safety considerations which dictate that the battery
should only start to recharge when the computer has reached a safe temperature to
do so.

Make sure you save your work when the battery LED is blinking orange, and plug
in the AC/DC adapter. The battery LED will change from blinking orange to orange
when the battery starts to charge (3 to 20 minutes before charging begins).

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.
3 - 10 Battery Information
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Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
Battery Information 3 - 11
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel pro-
vides an easy point of ac-
cess for information on
battery status, power plans
used and wireless device
status etc.

Figure 3 - 6
Windows Mobility 

Center
3 - 12 Conserving Battery Power
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “” on page 3
- 9 for more information on how to maintain and properly recharge the battery pack.)
Battery Life 3 - 13
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
3 - 14 Battery Life
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
Battery Life 3 - 15
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
3 - 16 Battery Life
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
Battery Life 3 - 17
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual CD-
ROM (Win Vista OR WinXP) contains the drivers and
utilities necessary for the proper operation of the com-
puter. There will be two CDs provided; one will con-
tain drivers for Windows Vista, the other will contain
drivers for Windows XP (make sure you install the ap-
propriate drivers for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page E - 35 for Windows XP information).

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN, Bluetooth, PC Camera and Fingerprint
Reader modules are provided in “Modules & Op-
tions” on page 7 - 1.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and click Install Vista Drivers (button).

If you wish to install the drivers manually see page 4 -
3.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 

Figure 4 - 2 - Drivers Installer Screen 2

Note the Fingerprint
Utility will only appear if
you have included the Fin-
gerprint Reader Module in
your purchase option
(Models B & C only). The
Quick Button Utility only
appears if you DO NOT
have a PC Camera Module
installed (Models A & B
only).
4 - 2 Driver Installation
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Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and
then browse to the executable file in the location listed in the table below and follow the installation procedure
for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.
.

Table 4 - 1 - Driver Location

Driver Page # Driver Location

Video (VIA - Model A) Page 4 - 5 Vista 32bit: X:\Drivers\Video\setup.exe

Video (NVIDIA - Models B & C) Page 4 - 5 Vista 32bit: X:\Drivers\Video\setup.exe

Audio Page 4 - 5 Vista 32bit: X:\Drivers\Audio\SETUP.EXE

Modem Page 4 - 5 Vista 32bit: X:\Drivers\Modem\ssetup.exe

LAN Page 4 - 5 Vista 32bit: X:\Drivers\LAN\setupvis.exe

CardReader Page 4 - 6 Vista 32bit: X:\Drivers\CardReader\Setup.exe

TouchPad Page 4 - 6 Vista 32bit: X:\Drivers\Touchpad\setup.exe

Hot Key Utility (Model C Page 4 - 6 Vista 32bit: X:\Drivers\Hotkey\Setup.exe

Quick Button Utility Page 4 - 6 Vista 32bit: X:\Drivers\QButton\3AP.exe

802.11 b/g USB WLAN Module Page 7 - 2 Vista 32bit: X:\Drivers\WLAN\setup.exe

Bluetooth Module Page 7 - 7 Vista 32bit: X:\Drivers\Bluetooth\setup.exe

PC Camera Module Page 7 - 12 Vista 32bit: X:\Drivers\Camera\setup.exe

Fingerprint Reader Module Page 7 - 18 Vista 32bit: X:\Drivers\FingerPrint\Application\x86\autorun.exe
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the driver
install procedure), click Cancel to close the window,
and follow the installation procedure as directed.
4 - 4 Driver Installation
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Driver Installation Procedure

Video (VIA - Model A)
1. Click 1.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Video (NVIDIA - Models B & C)
1. Click 1.Install Video Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Audio
1. Click 2.Install Audio Driver > Yes. 
2. Click Next.
3. Click the button to accept the license and click 

Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click OK.
3. The network settings can mow be configured.

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
Driver Installation 4 - 5
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CardReader
1. Click 5.Install CardReader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click Finish > Restart Now to restart the com-

puter.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 8.

Hot Key Utility (Model A & B Computers)
1. Click 7.Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Hot Key Utility (Model C Computers)
1. Click 7.Install Hotkey Utility > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Quick Button Utility
If you do not have a PC Camera module installed,
then the Quick Button Utility will appear in the Driv-
ers Installer menu (only install the quick button
driver if the PC Camera is not installed). See
Table , on page 1 - 10 and “Application Quick But-
tons” on page 2 - 11 for details.

1. Click 10.Install QButton Utility > Yes.
2. Click Next.
3. Click Finish to restart your computer.
4 - 6 Driver Installation
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Wireless LAN
See the introduction in “802.11 b/g USB WLAN Mod-
ule” on page 7 - 2, and check the installation proce-
dure.

Bluetooth
See the introduction in “Bluetooth Module” on
page 7 - 7, and check the installation procedure.

PC Camera
See the introduction in “PC Camera Module” on
page 7 - 11, and check the installation procedure.

Fingerprint Module
See the introduction in “Fingerprint Reader Module”
on page 7 - 18, and check the installation procedure.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers can-
not co-exist.

If you wish to add a PC Camera module to your comput-
er at a later date, then uninstall the Quick Button Driver
(entitled Multimedia Keyboard Driver)  before install-
ing the PC Camera and driver. Drivers can be unin-
stalled from the Programs and Features (Programs >
Uninstall a program) control panel in Windows.

If you wish to remove a PC Camera module from your
computer at a later date, then uninstall the PC Camera
Driver after removing the camera module. You can then
insert the Device Drivers & Utilities + User’s Manual
CD-ROM and install the Quick Button driver from the
Driver Installation menu.
Driver Installation 4 - 7
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1



BIOS Utilities

5

The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) NB
Copyright 1985-2005 Phoenix Technologies Ltd.
All Rights Reserved
Bios Version: ******
KBC/EC Firmware Version: ******

FSB 166*4MHz DDR533 CL=4T Dual Channel 2T ,CPU ID = 06E8
CPU = 1 Processors Detected, Cores per Processor = 2
Genuine Intel (R) CPU T2300 @ 1.66GHz
632K System RAM Passed
1022M Extended RAM Passed
2048 KB L2 Cache
System BIOS shadowed
Video BIOS shadowed
ATAPI CD-ROM: Optiarc CD-RW CRX880A
Fixed Disk 0: FUJITSU MHV2100BH PL
Mouse intialized

Press <F2> to enter SETUP

1

2

3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you
select a heading, a new screen appears. Scroll through the features listed on each
screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
5 - 4 The Power-On Self Test (POST)
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

System Time: [22:11:05]
System Date: [05/12/2007]

�IDE Channel 0 Master [Optiarc CD-RW CRX880A-(PM]
�IDE Channel 2 Master [FUJITSU MHV2100BH PL-(S1)]

System Memory 633 KB

Extended Memory 1022 MB

Main

06
Main Menu 5 - 5
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IDE Channel 0/2 Master (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of either a DVD/CD
Device or HDD on the computer’s IDE Channels. Use the Auto (Type:) setting to
have the items configured automatically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
5 - 6 Main Menu
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Advanced Menu

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

Frame Buffer Size

This item will appear for
Model A computers
(see overleaf).

Figure 5 - 3
Advanced MenuPhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Select the operating
system installed
on your system which
you will use most
commonly.

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavior.

Advanced

Installed O/S: [WinXP/Vista]
Boot-time Diagnostic Screen: [Enabled]
Legacy USB Support: [Enabled]
Reset Configuration Data: [No]
Advanced Menu 5 - 7
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Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (see “The
Power-On Self Test (POST)” on page 5 - 2).

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Note: The Frame Buffer Size item below is applicable to Model A computers only.

Frame Buffer Size: (Advanced Menu)
Use this menu item to set the amount of system memory to be allocated for use by
the integrated graphic system for Model A computers. The default memory size
allocated is 128MB, and this may be adjusted to 64MB or 256MB if required.
5 - 8 Advanced Menu
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to
the computer OS, (only the Setup utility) unless you choose to set a Password on
Boot (see over).

Security Menu

The changes you make
here affect the access to
the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu

PhoenixBIOS Setup Utility

Main Advanced SSeeccuurriittyy BBoot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.

Security

Supervisor Password Is: Clear

Set Supervisor Password [EEnntteerr]

Password on boot: [Disabled]
Fixed disk boot sector: [Normal]
Security Menu 5 - 9
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “En-
abled” is selected, only users who enter a correct password can boot the system (see
the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
5 - 10 Security Menu
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Win-
dowsXP) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 5
Boot Menu

PhoenixBIOS Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<x> exclude or include
the device to boot.
<Shift +1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Boot priority order:
1: IDE 0: Optiarc CD-RW CRX880A-(PM)
2: IDE 4: FUJITSU MHV2100BH PL-(S1)
3: USB FDC:
4: USB KEY:
5: USB HDD:
6: PCI BEV: VIA Boot Agent
7:
8:

Excluded from boot order:
: USB CDROM:
: USB ZIP
: USB LS120
: PCI SCSI

Main Advanced Security Boot Exit
Boot Menu 5 - 11
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Execute Command F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes
5 - 12 Exit Menu
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1
2

3

2

3

1

Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page D - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove the HDD bay cover screws  -  (Models A & B)/  -  (Model C).
3. Remove the HDD bay cover .

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay & 

Screw

1 3 1 4
5

321
4

321

55

Models A & B Model C
6 - 4 Upgrading the Hard Disk Drive
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4. Grip the tab and slide the hard disk in the direction of arrow .

5. Lift the hard disk up in the direction of arrow .
6. Remove the screws  &  and cover .
7. Reverse the process to install a new hard disk drive.

6

6 6

Models A & B Model C Figure 6 - 3
HDD Slide

Figure 6 - 4
HDD Removal

7
8 9 10

77 8

9

Model C Models A & B 

10
Upgrading the Hard Disk Drive 6 - 5
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Remove the HDD bay cover screws  -  (Models A & B)/  -  (Model C).
3. Remove the HDD bay cover .
4. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
5. Reverse the process to install the new device.

Figure 6 - 5
Removing the CD/

DVD Device

1 3 1 4
5

6
7

321
4

321

55

Models A & B Model C

6

7

6 - 6 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page D - 2 for
details of supported module types). 

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the CPU/RAM bay cover and remove screws  - .1 7

3 4

2

5

1

6

7
3 4

2

5

1

6

7
Models Model C
A & B

Figure 6 - 6
CPU/RAM Bay 

Screws
Upgrading the System Memory (RAM) 6 - 7
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3. Remove the bay cover .

4. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 8.

8

8 8

Models Model C
A & B

Figure 6 - 7
CPU/RAM Bay 

Cover Removed

9 10

9 10

9 10

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 8
RAM Module 

Release Latches
6 - 8 Upgrading the System Memory (RAM)



Upgrading The Computer

6

5. The RAM module will  pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.
7. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
8. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

9. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

10. Replace the bay cover and screws.
11. Restart the computer to allow the BIOS to register the new memory configuration 

as it starts up.

11

11

Figure 6 - 9
RAM Module 

Removal
Upgrading the System Memory (RAM) 6 - 9
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part. Open-
ing this compartment, or
accessing the CPU in
any way, may violate
your warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
6 - 10 Upgrading the Processor
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• 802.11 b/g USB WLAN Module
• Bluetooth Module
• PC Camera Module
• Fingerprint Reader Module

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 
Overview 7 - 1
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802.11 b/g USB WLAN Module
If you have included an 802.11b/g USB WLAN module in your purchase option,
you will have the appropriate software provided for your module.

Before installing the 802.11b/g USB WLAN driver, make sure that the Wireless
LAN module is on. Use the Fn + F11 key combination (see “Function Keys” on
page 1 - 12) to toggle power to the Wireless LAN module. Make sure you install
the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

802.11 b/g WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click Install VISTA Drivers (button), and then click 8.Install WLAN 

Driver > Yes.
3. Click Finish to complete the installation.
4. The operating system is the default setting for Wireless LAN control in 

Windows Vista (see overleaf).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table , on
page 1 - 9/Table 1 - 5, on
page 1 - 12).
7 - 2 802.11 b/g USB WLAN Module



Modules & Options

7

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 1
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 2
Connect to a 

Network

Click icon Right-click icon
802.11 b/g USB WLAN Module 7 - 3
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 3
Connecting

Figure 7 - 4
Connection Status
7 - 4 802.11 b/g USB WLAN Module



Modules & Options

7

7. To disconnect from the wireless network you can click the taskbar wireless icon 
, and then select Connect or disconnect to access the network menu, and 

click Disconnect (or right-click the icon , and then click Disconnect from).
Security Enabled 

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 5
Disconnecting

Click icon

Right-click icon
802.11 b/g USB WLAN Module 7 - 5
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 6
Windows Mobility 

Center
7 - 6 802.11 b/g USB WLAN Module
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Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth mod-
ule is on. Use the Fn + F12 key combination (see “Function Keys” on page 1 - 12)
to toggle power to the Bluetooth module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install VISTA Drivers (button), and then click 9.Install Bluetooth 

Driver > Yes.
3. Choose the language you prefer, and click OK > Next.
4. Click the button to accept the license agreement, and then click Next.
5. Click Next > Install.
6. Click Finish, and the BlueSoleil icon  will appear on the desktop.
7. You can configure the settings at any time by going to the IVT Corpora-

tion BlueSoleil - Main Window (Start > Programs/All Programs > IVT 
BlueSoleil > BlueSoleil), or by clicking the desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table , on
page 1 - 9/ Table 1 - 5, on
page 1 - 12).
Bluetooth Module 7 - 7
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User Guides & Help

View the BlueSoleil
User Guides from the
Help Menu (or press the
F1 key) in the IVT Cor-
poration BlueSoleil -
Main Window control
panel. 

Click the Help menu
and select Contents
and Index. 

Look through  Getting
Started or select the ap-
propriate User Guide
from the Contents
menu.

Figure 7 - 7
BlueSoleil Main 
Window & Help
7 - 8 Bluetooth Module
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Bluetooth Local Area Connection
You can check the Bluetooth connection status from the Network and Sharing
Center:

1. Use the Fn + F12 key combination to turn on the Bluetooth module.
2. Run the IVT Corporation BlueSoleil program from the desktop icon or Start menu.
3. Click Start, and click Control Panel (or point to Settings and click Control Panel).
4. Double-click Network and Sharing Center (Network and Internet).
5. Click Manage network connections.
6. The Bluetooth connection status will then be displayed in the control panel.

7. To disconnect click File from the IVT Corporation BlueSoleil - Main Window, 
and select Exit (the Local Area Connection will then display “Network cable 
unplugged”).

Disconnecting

In order to have the Local
Area Connection icon dis-
play the correct connection
status, you will need to exit
the IVT Corporation Blue-
Soleil - Main Window by
clicking the File menu and
selecting Exit (see over).

After exiting the program
you can then use the Fn +
F12 key combination to
turn off the Bluetooth mod-
ule.

If you use the close button,
or turn off the Bluetooth
module (by using the Fn +
F12) the icon will not dis-
play the correct status 

Figure 7 - 8
Local Area 
Connection
Bluetooth Module 7 - 9
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8. Do not use the close  button or Fn + F12 key combination before clicking File >
Exit or the correct status will not be displayed.

9. You can then use the Fn + F12 key combination to turn off the Bluetooth module
(check the LED icon for the Bluetooth module power status).

Figure 7 - 9
Bluetooth 

Disconnected
7 - 10 Bluetooth Module
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function Keys” on page 1 - 12) to
toggle power to the PC Camera module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3. 

Taking Still Pictures

You can use the applica-
tion button  (Model A
& B computers) to take
still pictures if you have
installed the hot key driv-
er. (See “PC Camera
Hot Key Buttons” on
page 7 - 17.)

Color Scheme Setup

Before running the PC
Camera application
(BisonCap), make sure
the Color Scheme in Win-
dows Vista is set to Win-
dows Aero (Control
Panel > Appearance
and Personalization >
Personalization > Win-
dows Color and Ap-
pearance).

Latest PC Camera Driver Information

Check the CD, and any accompanying insert pages for the latest updated information on
the PC Camera driver, that may override the information provided here.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the
Quick Button Utility Driver (entitled Multimedia Keyboard Driver)  before installing the PC
Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control
panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then unin-
stall the PC Camera Driver after removing the camera module. You can then insert the De-
vice Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button Utility
driver from the Drivers Installer menu.
PC Camera Module 7 - 11
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PC Camera Driver Installation
1. Make sure the module is powered on (click Cancel if you see a “New 

Hardware Found” message), and then insert the Device Drivers & Utilities 
+ User’s Manual CD-ROM into the CD/DVD drive.

2. Click 10.Install Camera Driver > Yes.
3. Choose the language you prefer and click Next.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Setup your Windows Color and Appearance to Windows Aero before run-

ning the BisonCap application (see “Color Scheme Setup” on page 7 - 11).
7. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

Model A & B Computers Only
8. You can use the application button  to run the BisonCap application if 

you have installed the hot key driver (see “Hot Key Utility (Model C Com-
puters)” on page 4 - 6).

9. A Snapshot folder will be placed on the desktop to record still pictures 
taken with using the application button  (see “PC Camera Hot Key But-
tons” on page 7 - 17).

PC Camera Power 
Error

The BisonCap applica-
tion may not recognize
that the camera module
is powered on if you
manually put the sys-
tem into Sleep or Hiber-
nate, and then resume,
when the BisonCap ap-
plication is still running. 

Before putting the sys-
tem into a power-saving
state close the Bison-
Cap application. If you
resume from a power-
saving state and see an
error message dis-
played by the BisonCap
application, simply quit
the application and run it
again.
7 - 12 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (VIA High Definition Audio) and make sure the item is not 

disabled (if you wish to record from the internal microphone make sure that the 
Front Mic is not disabled).

5. Double-click Microphone/Front Mic (or select Properties from the right-click 
menu).

6. Click Levels (tab), and adjust the Microphone/Front Mic slider to the level 
required.

7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu (or press the application button ).
9. Go to the Devices menu heading and select the appropriate recording device (it 

should have a tick alongside it) e.g Front Mic (VIA High Definition).... or 
Microphone (VIA High Definition).... .

10. Go to the Capture menu heading and select Capture Audio (it should have a tick 
alongside it).
PC Camera Module 7 - 13
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Right-click

Figure 7 - 10
Audio Setup for PC 

Camera
7 - 14 PC Camera Module
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.
1. Setup your Windows Color and Appearance to Windows Aero before running 

the BisonCap application (see “Color Scheme Setup” on page 7 - 11).
2. Run the BisonCap application from the Start > Programs/All Programs > 

BisonCam menu (it is recommended that you set the capture file before the 
capture process - see Set Capture File below).

3. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 13) and select Start Capture.

4. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

5. Click OK to start capturing the video, and press Esc to stop the capture.
6. If you wish to, you may go to the File menu and select Save Captured Video 

As..., choose a file name and location, and then click Open (you can view the file 
using the Windows Media Player).

Set Capture File
In the BisonCap application you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will
automatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the BisonCap applica-
tion. You can choose to
ignore this by clicking
Cancel.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

You may find it helpful to
defragment the HDD be-
fore capture.
PC Camera Module 7 - 15
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap application is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 11
Video Capture Filter
7 - 16 PC Camera Module
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PC Camera Hot Key Buttons
(Model A & B Computers)
You can use the PC Camera hot key buttons (the quick button utility must NOT be
installed - see “Quick Button Utility” on page 4 - 6)    to run the BisonCap
program, to take still pictures and to zoom the camera in and out (if you have in-
stalled the hot key and PC Camera drivers - see “Hot Key Utility (Model C Comput-
ers)” on page 4 - 6 & “PC Camera Driver Installation” on page 7 - 12).

1. Make sure the PC Camera is on (use the Fn + F10 key combination to power on 
the camera).

2. Press the  application button once.
3. The BisonCap application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the  application button for a second time (you will hear a camera motor 

sound to indicate the picture is being taken).
6. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture
using the application hot
key button.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure 7 - 12
Snapshot Folder
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Fingerprint Reader Module
(Optional for Model B & C Computers)
If you have included the fingerprint reader in your purchase option (Optional for
Model B & C computers only) you will need to install the driver as per the instruc-
tions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM into the 

CD/DVD drive.
2. Click Install Vista Drivers (button).
3. Click 11.Install Fingerprint Utility > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
CD-ROM and click Install
Vista Drivers (button).
Click Unlock (button) and
then click 11.Fingerprint >
Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual CD-ROM and click
User’s Manual (button),
and click Install Acrobat
Reader (button).
7 - 18 Fingerprint Reader Module
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, 

or double click the taskbar icon .
2. On the first run of the program you will be asked to click the button to accept the 

license, and then click OK.
3. Click Next and select “Enrollment to the hard disk”, and click Finish.

4. If you have not set a Windows password you will be prompted to do so (note: If 
you have not set a password Protector Suite QL cannot secure access to your 
computer).

5. Click Next.
6. You will then be prompted to enter your Windows password.
7. Click Next > Next (if you have the “Run interactive tutorial” tickbox selected you 

will run through the Fingerprint Tutorial).
8. Click Next for each window of the tutorial (you can click the button to “skip 

tutorial” at any time).

Figure 7 - 13
Enroll to Hard Disk
Fingerprint Reader Module 7 - 19
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9. Click the button above any of the fingers to begin the enrollment process for that 
finger.

10. Swipe the finger three times to enroll that finger.
11. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Next.
12. Click Finish.
13. Click any of the headings under “Learn more about:” to get more information on 

any topic.
14. Click Close.

15. Restart the computer.
16. Right-click the taskbar icon  to bring up the menu that allows you to Edit 

Fingerprints, Start Control Center, access the Help menu etc. You can also run 

Fingerprint 
Enrollment

Note that it is strongly
recommended that you
enroll more than one
finger in case of injury
etc. 

Figure 7 - 14
Fingerprint 
Enrollment
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the Control Center etc. from the Protector Suite QL item in the Programs/All 
Programs menu.

17. See “Help & Manual” on page 7 - 18 for further details.
18. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, open the Control Center and access 
the Help menu.

19. The Control Center allows you to change the Settings, enroll Fingerprints and 
get Help.

Figure 7 - 15
Control Center & 

Biomenu 
Fingerprint Reader Module 7 - 21
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power Plans” on page 3 - 4/“Power-Saving States” on page 3 - 6), the 
Fn + F4 key combination, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Password Warning” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4/“Power Schemes” on page E - 25) check its settings. You may also be
using an PC Card/ExpressCard device/USB device/external device that is drawing a lot of power.

Actual battery
operating time is
shorter than expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10/“Battery Information” on page E - 30).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable the
options.

A peripheral device/USB device/PC Card is consuming a lot of power. Turn off/remove the
unused device to save power.
Problems and Possible Solutions 8 - 7
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The battery recharging
time (for Model B & C
computers) is longer
than expected.

The computer has been working under a heavy load, and the system is allowing the system to
cool to a safe temperature before charging begins. Model B & C computers under a heavy load
(e.g. using applications which require a lot of video processing), while running on battery power,
will take time (3 to 20 minutes before charging begins) to recharge the battery when plugged in to
the AC/DC adapter. This is due to safety considerations which dictate that the battery should only
start to recharge when the computer has reached a safe temperature to do so.

Make sure you save your work when the battery LED is blinking orange, and plug in the AC/DC
adapter. The battery LED will change from blinking orange to orange when the battery starts to
charge (3 to 20 minutes before charging begins).

The computer feels too
hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 16). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan
intakes to be blocked.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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Nothing appears on
screen.

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 (see
“Configuring the Power Buttons” on page 3 - 8/“Sleep Button” on page E - 29).

The screen controls need to be adjusted. Toggle the screen control key combinations Fn + F8/F9.
If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn + F7. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
Appendix B/“Video Features” on page E - 10 for instructions on installing and configuring the
video driver.

You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems and Possible Solutions 8 - 9
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The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Function Keys/Hot Keys”
on page 2 - 9) to adjust.

The audio recording
cannot be heard or the
volume is very low.

The recording volume might be set too low. Check the information in “Recording Audio” on
page 2 - 12/“Recording Audio” on page E - 7.

Audio cannot be heard
through the recording
line-in jack.

The Recording Line-In jack allows you to record audio sources to the computer. Note that the
audio will not play through the computer’s speakers. You will need to listen to the audio
source on the original device, or split the audio signal through the notebook computer and
another device.

The CD/DVD cannot be
read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will
not open when there is
a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc using the eject hole
(see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5/
“DVD Regional Codes” on page E - 2.

Unwelcome numbers
appear when typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 9).

Problem Possible Cause - Solution
8 - 10 Problems and Possible Solutions
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The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn
+ F4) key combination, or press the power button if no LEDs are lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power Plans” on page 3 - 4/“System Power Options” on page E
- 27).

The Wireless LAN/
Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator  and/or function key indicator to see if the
WLAN/Bluetooth module is on or off (see “LED Indicators” on page 1 - 9). If the LED indicator is
off, then press the Fn + F11 (WLAN) or Fn + F12 (Bluetooth) key combination(s) in order to
enable the modules (see “Function Keys” on page 1 - 12).

The PC Camera module
cannot be detected.

The module is off. Press the Fn + F10 key combination in order to enable the module (see
“Function Keys” on page 1 - 12). Run the BisonCap program (see “PC Camera Module” on
page 7 - 11/“PC Camera Module” on page E - 46) to view the camera picture.

Problem Possible Cause - Solution

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
Problems and Possible Solutions 8 - 11
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The Wireless LAN/
Bluetooth/ PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions for the appropriate module in “Modules &
Options” on page 7 - 1).

The BisonCap PC
Camera application
displays the message
“Sorry, please turn on
the Video Capture
power (Fn + F10).” after
resuming power from
manually entering a
power-saving state.

The BisonCap application may not recognize that the camera module is powered on if you
manually put the system into Sleep or Hibernate, and then resume, when the BisonCap
application is still running. 

Before putting the system into a power-saving state close the BisonCap application. If you
resume from a power-saving state and see the error message displayed by the BisonCap
application, simply quit the application and run it again.

The audio at Windows
startup, or when playing
mp3 format files in
Windows Media Player,
appears to lag (Model B
& C computers only).

This is a known issue with Celeron M CPUs. Contact your service center for CPU upgrade
information.

The Bluetooth module
is off after resuming
from Sleep (Model B &
C computers only).

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

Problem Possible Cause - Solution
8 - 12 Problems and Possible Solutions
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Screen Resolution Error
If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista then follow the instructions below to fix this problem. This error arises in compliance with Win-
dows Vista policy, which triggers TMM (Transient Multi-Manger) when the notebook lid (S3) is closed. TMM
disconnects the LCD display from the OS and then adds the LCD display back when the lid is opened. This may
trigger TMM to restore an old display setting which may result in screen flickering or a screen resolution change.
To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and 
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

Figure 8 - 1 - AC/DC Adapter In
Screen Resolution Error 8 - 13



Troubleshooting

8

3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

Figure 8 - 2 - TMM Disable
6. Close all the control panels.
8 - 14 Screen Resolution Error
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Recording Line-In Jack The Recording Line-In jack allows you to record audio sources to the computer. Note that the
audio will not play through the computer’s speakers. You will need to listen to the audio
source on the original device, or split the audio signal through the notebook computer and
another device.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
A - 2 Interface (Ports & Jacks)
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RJ-11 Modem Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection. 
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
Interface (Ports & Jacks) A - 3
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Appendix B: VIA Video Driver Controls
(Model A Computers)
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 16.

VIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.
Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install
Vista Drivers (button).

Video
1. Click 1.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
VIA Video Driver Installation B - 1
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Advanced Video Controls
This section is about making adjustments for the LCD, and switching display devic-
es. The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 15.

Video Driver Controls
The video interface lets you change the screen resolution and color output to what-
ever is most comfortable/efficient for you. This is a matter of hardware, video mem-
ory and the driver for your operating system.

Video Memory
The system does not feature dedicated video memory, but automatically and dynam-
ically allocates as much (up to 256MB maximum) system memory (RAM) as need-
ed to the video system. You can define the amount of system memory to be allocated
from the BIOS (see “Frame Buffer Size: (Advanced Menu)” on page 5 - 8). The
system returns whatever memory is no longer needed to the operating system.

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.
B - 2 Advanced Video Controls
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Attaching Other Displays
Besides the built-in LCD, you can also use an external monitor (CRT)/flat panel dis-
play as your display device. Connect it to the external monitor port on the right of
the computer, and follow the instructions below:

Windows Vista
1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 1
 New Display 

Detected
Attaching Other Displays B - 3
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External displays may also be configured from S3Display tab in Advanced Display
Settings:
1. Attach the external display to the external monitor port and turn it on.
2. Click Advanced Settings in the Display Settings control panel (see “Video

Features” on page 1 - 18) to display the additional tabs.
3. Select S3Display (tab).
4. Click to put a tick in the tickbox under the CRT icon.
5. Click Apply > OK and allow the monitor time to refresh the display.
6. Click Yes to confirm the settings.
7. Select the CRT icon, and then click Refresh Rate to change the settings for the

attached display.

Figure B - 2
 S3 Display 
B - 4 Attaching Other Displays
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Display Modes
Single Display
Only one of your attached displays is used.

Mirrored
This display mode simply shows an exact copy of the Primary display desktop on
the Secondary display(s). 

Extended Desktop
An Extended desktop allows the desktop to span the displays to act as a large work
area, thus creating a lot more screen area for display. Each display device can be con-
figured independently for specific resolutions and refresh rates. Use the Display Set-
tings control panel to drag the monitors to match the physical arrangement you wish
to use.
Display Modes B - 5
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Using Windows Vista to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 3
New Display 

Detected
B - 6 Display Modes
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 18).
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend my

Windows desktop onto this monitor.” and click Apply.

Figure B - 4
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Display
 is on the left, the Secondary Dis-

play  is on the right.

2

1
2
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Non DDC CRT Monitors (for Win Vista Only)
If you are experiencing screen flicker problems (in Windows Vista ONLY) when us-
ing an older CRT (Non DDC) as your external display, you can install an updated
driver to fix this problem. Follow the steps below:

Uninstall the Original Driver
1. Detach any connected external CRT.
2. Go to the Control Panel in the Windows OS and double-click the Programs and

Features icon (Programs > Uninstall a program).
3. Click to select the VIA Display Vista Driver *****, and then click Uninstall and

follow the on screen prompts.
4. Click Yes to restart the computer.

Install the Updated Driver
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM.
2. Click Browse (button).
3. Navigate (Browse...) to X:\Drivers\Video_NonDDC\ and double-click setup.exe.
4. Click Next > Next.
5. Click Finish to restart the computer.
6. Reattach the external CRT and configure as outlined in “Attaching Other

Displays” on page B - 3.
B - 8 Non DDC CRT Monitors (for Win Vista Only)
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Appendix C: NVIDIA Video Driver Controls
(Model B & C Computers)
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 18.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install
Vista Drivers (button).

1. Click 1.Install Video Driver > Yes.
2. Click Next.
3. Click the “Yes, I want to restart my computer now.” button, and click Fin-

ish to restart the computer.

Resolution Error

If you are experiencing
screen resolution prob-
lems/screen flickering after
resuming from Sleep in
Windows Vista (for NVID-
IA Models B & C only) see
page 8 - 13.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes.
The figures and information in this chapter are intended as a guideline, however the control pan-
els etc. may be changed depending on the video driver release version.
NVIDIA Video Driver Installation C - 1
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display Settings (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

NVIDIA Control 
Panel 

To access the Ge-
Force..... control pan-
el from the desktop;
right-click the desk-
top, then click NVIDIA
Control Panel.

Figure C - 1
NVIDIA GeForce 

Control Panel
C - 2 NVIDIA Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allows quick access to features such as display configuration, 3D Set-
tings and Help menus etc. Navigating the 

Control Panel 

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the headings,
menus and highlighted
links for information.
Use the buttons on the
top left to go back, for-
ward etc.

Figure C - 2
NVIDIA Control 

Panels
NVIDIA Control Panel C - 3
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure C - 3
Help Menus
C - 4 NVIDIA Control Panel
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Attaching Other Displays
Configuring an External Display in Windows Vista
1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The fol-
lowing are the display
options:

• The built-in LCD.
• An external monitor 

connected to the 
external monitor port.

• A flat panel display 
connected to the 
external monitor port.

Figure C - 4
New Display 

Detected
Attaching Other Displays C - 5
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Configuring an External Display using the NVIDIA Control Panel
1. Attach your external display to the external monitor port and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Click Display, and then click Change display configuration.

4. Choose the nView display mode you wish to use (see page C - 7).
5. Select the displays you want to use (if your display is not shown click “My Display

is not shown in the list...”, and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through some dis-
play options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Figure C - 5
Change Display 
Configuration
C - 6 Attaching Other Displays
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Display Modes
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When Dualview is enabled, you can
drag any icons or windows across to the other display desktop. It is therefore possi-
ble to have one program visible in one of the displays, and a different program visi-
ble in the other display.
Display Modes C - 7
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Using New Display Detected to Enable Extended Mode
1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure C - 6
New Display 

Detected 
(Extended)
C - 8 Display Modes
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control

Panel).
3. Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure C - 7
Display Settings 

(Extend the 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2

Display Modes C - 9
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Appendix D: Specifications

Feature Specification

Processor Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T7200/ T7400/ T7600

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 667MHz FSB
2.0/ 2.16/ 2.33 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T5500/ T5600

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Core™ Duo Processor
(478-pin) Micro-FC-PGA Package
T2300/ T2400/ T2500/ T2600/ T2700 

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83/ 2.0/ 2.16/ 2.33 GHz

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check
with your service center for details.
Specifications D - 1
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Processor Intel® Core™ Solo Processor
(478-pin) Micro-FC-PGA Package
T1300/ T1400

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Celeron® M Processor
(478-pin) Micro-FCPGA Package
410/ 420/ 430/ 440/ 450

65nm (65 Nanometer) Process Technology
1MB On-die L2 Cache & 533MHz FSB
1.46/ 1.60/ 1.73/ 1.86/ 2.0 GHz

Core Logic VIA VN896 + VT8237A Chipset

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533/667 MHz
64-bit Wide DDRII (DDR2) Data Per Channel
Memory Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules)

LCD Models A & B Model C

15.4" WXGA (1280 * 800) TFT LCD 
OR

15.4‘” WSXGA+ (1680 * 1050) TFT LCD 
(for Model B Computers Only)

17.0" WXGA (1440 * 900) TFT LCD
OR

17.1" WSXGA+ (1680 * 1050) TFT LCD
OR

17.1" WUXGA (1920 * 1200) TFT LCD

Feature Specification
D - 2 Specifications
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Video Adapter Model A Models B & C

VIA VN896 Integrated Video System 
(Internal On Chip)

Integrated 128bit 2D/3D Graphic Engine and 
Clock up to 250MHz
Supports CRT Resolutions up to 2048 * 1536 
at 85Hz
Supports Microsoft DirectX 9.0

NVIDIA GeForce Go 8400M G (NB8M-SE) 
Discrete Video System (External On Board)

TurboCache™ Total Graphics Memory up to 
895MB (with System Memory)
Supports Dual Display and Ergonomic Refresh 
Rates up to 2045 * 1536 at 85Hz Supports 
Microsoft DirectX 10.0 Applications and Shader 
Model 4.0
128MB Using On Board DDRIII (DDR3) Memory

Security Security (Kensington® Type) Lock Slot BIOS Password

BIOS One 4Mb Flash ROM Phoenix™ BIOS

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page D - 5 for 
drive options)
Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD

Audio Integrated AZALIA Compliant Interface (HDA)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible
2 * Built-In Speakers
Built-In Microphone

Feature Specification
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Keyboard & 
Pointing Device

Winkey Keyboard Built-In TouchPad with Scrolling Function

Interface Three USB 2.0 Ports
One RJ-11 Modem Jack
One RJ-45 LAN Jack
One DC-in Jack

One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One Recording Line-In Jack
One S/PDIF Out Jack

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) Note: MS Duo/ 
Mini SD/ RS MMC Cards require a PC adapter

ExpressCard Slot One ExpressCard/34(54) Slot

Communication AZALIA 56K Plug & Play Fax/Modem V.90/92 Compliant
10M/100Mb Base-T Ethernet LAN 
802.11 b/g USB Wireless LAN Module (Option) 
Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)
300K or 1.3M Pixel USB PC Camera Module (Factory Option) 

Power 
Management

Supports ACPI 2.0 and PCI Bus Power 
Management 1.1 Compliant

Battery Low Suspend
Supports Wake on LAN

Feature Specification
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Power Models A & B Model C

Full Range AC/DC Adapter AC input 100 - 240V, 
50 - 60Hz, DC Output 19V, 3.42A (65 Watts) OR 
18.5V, 3.5A (65 Watts)

Full Range AC/DC Adapter AC input 100 - 240V, 
50 - 60Hz, DC Output 19V, 4.74A (90 Watts) 

Battery 6 Cell Smart Lithium-Ion Battery Pack, 4000mAH/4400mAH

Environmental 
Spec

Temperature
Operating:    5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Dimensions 
& Weight

Models A & B Model C

360mm (w) * 267mm (d) * 25.4-34mm (h)
2.6 kg With 6 Cell Battery

397mm (w) * 280.5mm (d) * 39mm (h)
2.98 kg +/- 3% With 6 Cell Battery and Without 
Optional Modules

Optional Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module (Super Multi)

Fingerprint Reader Module 
(Factory Option for Models B & C Only)

802.11 b/g USB Wireless LAN Module 

300K or 1.3M Pixel USB PC Camera Module 
(Factory Option)

Bluetooth 2.0 + EDR (Enhanced Data Rate) 
Module (Factory Option) 

Feature Specification
Specifications D - 5
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Appendix E: Windows XP Information
This Appendix contains information (including control panel information, driver in-
stallation etc.) for users of the Windows XP OS.

Model C Computers

Note that Model C com-
puters do not support
the audio record or cam-
era zoom hot keys func-
tions.

You may configure the
 Application Hot Key

(for one application) as
outlined in “Application
Quick Buttons” on
page E - 6.
E - 1
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DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table E - 1 - DVD Region Codes Figure E - 1 - DVD Regions

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.
Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
E - 2 DVD Regional Codes
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure E - 2 - Start Menu & Control Panel

Click here to toggle Category View

 

Windows XP Start Menu & Control Panel E - 3
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one
of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page E - 39) you can configure the functions
by double-clicking the TouchPad driver icon  on the taskbar. You may then configure the TouchPad tapping,
buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Figure E - 3 - Mouse Properties

Mouse Driver

If you are using an external mouse
your operating system may be able to
auto-configure your mouse during its
installation or only enable its basic
functions. Be sure to check the de-
vice’s user documentation for details.
E - 4 TouchPad and Buttons/Mouse
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Function Keys/Hot Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key
is held down. Table 2 - 2, on page 2 - 10 gives details of function key combinations,
hot key buttons and visual indicators (for Model A & B computers).

Model A & B Computers
In addition to the basic function key combinations visual indicators are available
when the hot key driver is installed (see “Hot Key Utility (Model C Computers)” on
page E - 39). After installing the driver an icon  will appear in the taskbar.

The hot key buttons give quick access to the default internet browser  and e-mail
program . The PC Camera hot key buttons    can be used to run the Bison-
Cap application, to take still pictures and to zoom the camera in/out (see “PC Cam-
era Hot Key Buttons” on page E - 52) if a PC Camera module is installed (this does
not apply to Model C - see page E - 1). If you do not have a PC Camera module in-
stalled see “Application Quick Buttons” on page E - 6 for details.

Model C Computers
There are no visual indicators available for Model C computers, however you can
configure an application (Application 1) to open when the hot key  button is
pressed (see “Application Quick Buttons” on page E - 6).

Application Note

The key functions will
only be displayed if the
program is running (i.e.
the icon  is displayed
in the taskbar). If you
have closed the pro-
gram you can run it
again from the Start
menu (Start > Pro-
grams > Startup > Hot-
Key Driver) in
Windows.
Function Keys/Hot Keys E - 5
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Application Quick Buttons
Note that the application quick button utility is designed to allow use of the hot key
buttons in absence of the optional PC Camera (the quick button utility will only ap-
pear if no PC Camera is installed). You will need to install the Quick Button Util-
ity (see “Quick Button Utility” on page E - 39) to enable the functions.

The quick buttons give instant access to user-defined applications, with one quick
button press. To configure a program to open when the buttons    are pressed,
follow the instructions below. The quick buttons will function as long as the program
is running (the icon  will appear in the taskbar). If the program is not running you
will need to restart the computer.

1. Press a button    or right-click the icon  in the taskbar.
2. Select Setup from the menu, scroll to AP1/2/3 (or just Application 1 for Model C 

computers) and select Custom.
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the desired application.exe (see sidebar) program 

exists.
5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop and click Prop-
erties. Click the short-
cut (tab) and see where
the executable file is lo-
cated by clicking the
Find Target (button).

 Figure E - 4
Quick Button 
Configuration 

Screens
E - 6 Application Quick Buttons
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Recording Audio
(Model A & B Computers)
The  audio record hot key button allows you to record audio from either the built-in microphone, or from a
microphone connected to the microphone-in jack. To record on the computer, setup the audio recording options
in Windows as follows (see Figure E - 5 on page E - 8).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select HD Audio rear input (for a microphone plugged in to the microphone-in jack)/HD Audio Front Mic (for 

the built-in microphone) from the Mixer device menu and click OK (make sure there is a tick in the Microphone 
tick box).

5. Click Recording (button) and click OK.
6. Boost the volume in the Microphone section as high as it will go (make sure there is a tick in the Select tick box 

if you have selected HD Audio rear input).
7. Close the open windows.
8. You can also boost the microphone from the Mixer in the VIA Audio Deck  menu (see page E - 9).
9. Press the audio record button  to begin the recording process (the record icon  will flash in the top left of 

the screen).
10. Press the  audio record button again to stop the recording process (the record icon will disappear from the 

top left of the screen).
11. The recorded audio file (in .wav format) will appear in the Shared Documents > Wav folder in My Computer.
12. Double-click the file to playback the recorded audio.
Recording Audio E - 7
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Figure E - 5
Audio Setup for 

Recording 
(Windows XP)
E - 8 Recording Audio
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio
Devices  Windows control panel, or from the VIA Audio Deck  icon in the
taskbar, or on the desktop (this will bring up the VIA Audio Deck menu). The vol-
ume may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows (and the volume
control function keys on
the computer). Click the
Volume icon on the
taskbar to check the set-
ting.

 Figure E - 6
VIA Audio Deck 
Configuration 

Menus

Microphone 
    Boost
Audio Features E - 9
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Video Features
This computer features two different video (either VIA for Model A or NVIDIA for Model B & C Computers)
options (see “Video Adapter” on page D - 3 for details). You will be provided with an appropriate driver on the
Device Drivers & Utilities + User’s Manual CD-ROM (WinXP).

You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the video driver is installed. For further information see either “VIA Video Driver Con-
trols” on page E - 12 (from pages E - 12 to E - 16) or “NVIDIA Video Driver Controls” on page E - 17 (from
pages E - 17 to E - 21).

1. Click Start, point to Settings and click Control Panel (or click Control 
Panel).

2. Double-click Display (icon); Display (icon) is in the Appearances and 
Themes category.

3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution .
5. Click the arrow, and scroll to the preferred setting in Color quality .
6. Open the Display Properties control panel, and click Advanced (button) 

 to bring up the Advanced properties tabs. 
7. The Advanced properties tabs include specific VIA OR NVIDIA controls, 

which allow you to make any video adjustments you require.

Figure E - 7 - Display Properties

1
2

3

3

1 2
E - 10 Video Features
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Advanced Video Controls
This section is about making adjustments for the LCD, and switching display devic-
es.

Video Driver Controls
The video interface lets you change the screen resolution and color output to what-
ever is most comfortable/efficient for you. This is a matter of hardware, video mem-
ory and the driver for your operating system.

Video Memory
The Model A computer system does not feature dedicated video memory, but auto-
matically and dynamically allocates as much (up to 256MB maximum) system mem-
ory (RAM) as needed to the video system. You can define the amount of system
memory to be allocated from the BIOS (see “Frame Buffer Size: (Advanced
Menu)” on page 5 - 8). The system returns whatever memory is no longer needed to
the operating system.

NVIDIA TurboCache
NVIDIA® TurboCache™ technology (Model B & C computers only) allows the
GPU so share the capacity and bandwidth of dedicated video memory and dynami-
cally available system memory. The TurboCache Manager dynamically allocates
memory for maximum system performance.

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.
Advanced Video Controls E - 11
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VIA Video Driver Controls
(Model A Computers)

VIA S3Tray Plus Utility
The S3Tray Plus utility will appear in the taskbar when the video driver is installed.
Click/Right-click the icon  to bring up the menu below. From this menu you will
also be able to make display adjustments, access the Display Properties control panel,
check video memory information etc.Figure E - 8

S3Tray Plus Taskbar 
Utility

Click Icon
Right-Click

Icon
E - 12 VIA Video Driver Controls
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VIA S3 Display Control Panels
Right-click the S3Tray Plus utility  in the taskbar to bring up the menu for the
individual control panels, or access the menus from the Advanced tab in the Display
Properties control panel.

Help Menus

Right-click on almost
any item in the tabs to
bring up the “What’s
This?” button.

Click the “What’s
This?” button to bring
up a help menu (if the
item has a help menu
associated with it).

Figure E - 9
S3 Control Panels

Help Menu
VIA Video Driver Controls E - 13
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Display Devices (VIA)
Besides the built-in LCD, you can also use an external monitor (CRT)/flat panel dis-
play as your display device. Connect it to the external monitor port on the right of the
computer. See the instructions below:

1. Attach the external display to the external monitor port and turn it on.
2. Click Advanced in the Display Properties control panel (see “Video Features” on

page E - 10) to display the additional tabs.
3. Select S 3Display (tab).
4. Click to put a tick in the tickbox under the CRT icon.
5. Click Apply > OK and allow the monitor time to refresh the display.
6. Click Yes to confirm the settings.

S3Tray Plus Utility

You can also use the
S3Tray Plus utility in
the taskbar to config-
ure an external dis-
play.

Attach the external dis-
play (CRT) to the ex-
ternal monitor port.

Right-click the 
icon in the taskbar and
select S3Display.

Select the CRT (it
should have a tick
alongside it) and click
Yes to confirm the set-
tings.

Figure E - 10
S 3Display
E - 14 Display Devices (VIA)
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Display Modes (VIA)
Single Display
Only one of your attached displays is used.

Multiple Monitors
This display mode simply shows an exact copy of the Primary display desktop on
the Secondary display(s). 

Extended Desktop
An Extended desktop allows the desktop to span the displays to act as a large work
area, thus creating a lot more screen area for display. Each display device can be con-
figured independently for specific resolutions and refresh rates. Use the Display
Properties control panel to drag the monitors to match the physical arrangement you
wish to use.

Playing DVD Videos

If you want to play a
DVD video in a multiple
monitor mode, then
choose EITHER the
notebook LCD OR ex-
ternal display as the dis-
play device. It is not
possible to play a DVD
video simultaneously on
both displays.
Display Modes (VIA) E - 15
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To Enable Extended Desktop (Display Properties)
1. Attach the external display to the external monitor port and turn it on.
2. Go to the Display Properties control panel (see “Video Features” on page E - 10)

and click Settings (tab).
3. Click the monitor icon (e.g. ), and click to put a tick in the “Extend my Windows

desktop onto this monitor.” box, and then click Apply.
4. As long as the appropriate monitor icon is selected you can adjust the screen

resolution, color quality etc.
5. Click Apply > Yes to confirm any setting changes 

 Display Settings 
Extended Desktop 

Use the control panel
to drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any
icons or windows
across to either display
desktop, which makes
it possible to have one
program visible in one
of the displays, and a
different program visi-
ble in the other display.

Figure E - 11
Display Properties 

(Extended 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2

E - 16 Display Modes (VIA)
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NVIDIA Video Driver Controls
(Model B & C Computers)
More advanced video configuration options are provided in the GeForce..... control
panel tab.

1. Open the Display Properties (see “Video Features” on page E - 10) control panel.
2. Click Advanced (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel (click to select Standard or Advanced

options and click OK).

GeForce Control 
Panel 

To access the Ge-
Force..... control panel
from the desktop:

Right-click the desk-
top, then point to or
click NVIDIA Control
Panel.

Figure E - 12
NVIDIA Control 

Panels
NVIDIA Video Driver Controls E - 17
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Control Panels (NVIDIA)
The NVIDIA Control Panel provides additional video configuration controls and
tools which allows quick access to features such as display configuration, appear-
ance, mobile support and Help menus etc.

Navigating the 
Control Panel 

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the headings,
menus and highlighted
links for information.
Use the buttons on the
top left to go back, for-
ward etc.

The Help menus pro-
vide index and search
features, and direct
links to the NVIDIA
website etc.

Figure E - 13
NVIDIA Control 

Panels
E - 18 NVIDIA Video Driver Controls
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Display Devices (NVIDIA)
Besides the built-in LCD, you can also use an external monitor/flat panel display as
your display device. The following are the display options:
1. The built-in LCD.
2. An external monitor connected to the external monitor port.
3. A flat panel display connected to the external monitor port.

Configure the display modes (see over) for any attached display devices from the
Display control panel (Change Display Configuration - see page E - 21).

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Figure E - 14
Change Display 
Configuration
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Display Modes (NVIDIA)
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will
drive multiple displays with the same content and each display device can be configured independently.

Dualview Mode
Dualview Mode treats both connected displays as separate devices (unlike Horizontal/Vertical Span mode) act-
ing as a virtual desktop, resulting in a large workspace.

Horizontal/Vertical Span Mode
Horizontal/Vertical Span Mode treats both connected displays as a virtual desktop. Unlike Dualview, in Hori-
zontal/Vertical Span Mode the displays are not treated as separate devices and the taskbar will be stretched
across the displays. 3D applications are accelerated more efficiently in Horizontal/Vertical Span Mode.
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Attaching Other Displays (NVIDIA)
1. Attach your external display to the external monitor port and turn it on.
2. Go to the NVIDIA Control Panel.
3. Click Display, and then click Change Display configuration.

4. Choose the nView display mode you wish to use.
5. Select the displays you want to use (if your display is not shown click “My Display

is not shown in the list...”, and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through some dis-
play options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Figure E - 15
Change Display 
Configuration
Display Modes (NVIDIA) E - 21



Windows XP Information

E

Power Management Features
To conserve power, especially when using the battery, your computer uses the ACPI
power management system. Power management conserves power by controlling in-
dividual components of the computer (the monitor and hard disk drive) or the whole
system.

The Power Options control panel icon in Windows (see page E - 3) allows you to
configure power management features for your computer. You may conserve power
through individual components such as the monitor or hard disk, or you may use ei-
ther Stand by or Hibernate mode to conserve power throughout the system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage
the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable.
Battery life varies depending on the applications and the configuration you're using. To increase battery life,
let the battery discharge completely before recharging (see “How do I completely discharge the battery?”
on page E - 34).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery
Information” on page E - 30.
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Turn Off Computer
command from the Start
menu in Windows. This
will help prevent hard
disk or system prob-
lems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s
“Power Options” control panel to set the power button to send the system into Stand by or
Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on
page E - 29 for details).
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Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page E - 27).

Resuming 
Operation

Press a key on the key-
board, or move the
mouse/TouchPad to re-
sume from Monitor or
Hard Disk Stand by.

Figure E - 16
Power Schemes
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Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery
power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.
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System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Stand by and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate tab
in the Power Options control panel - see “Hibernate” on page E - 28).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to
press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs. 

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on
Stand by instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Stand by mode.

Stand by/Hibernate 
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667). 

Download and install the
Hotfix to correct this er-
ror.
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD be-
fore it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hiber-
nate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button.

System Resume

The system can resume
from Stand by mode by:

• Pressing the power
button

• Pressing the Sleep/
Resume key combi-
nation

• An incoming call
received on the
modem (if enabled)

• Network card (Wake
On LAN) activity (if
enabled)

Figure E - 17
Enable Hibernation
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hiber-
nate mode. In Stand by mode, the LED  will blink green. In Hibernate mode
the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving
mode set to save power through individual components (e.g. hard disk, monitor), the
LED will remain green.

Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4)
from the menu illustrat-
ed. In Windows this is
referred to as the Sleep
button.

Figure E - 18
Power Options

(Advanced - Power 
Buttons)

(Sleep) Button
Power Button Sleep/ResumeLid
Configuring the Power Button E - 29
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Charging on Model B & C Computers
Note that Model B & C computers under a heavy load (e.g. using applications which
require a lot of video processing), while running on battery power, will take time (3
to 20 minutes before charging begins) to recharge the battery when plugged in to the
AC/DC adapter. This is due to safety considerations which dictate that the battery
should only start to recharge when the computer has reached a safe temperature to do
so.

Make sure you save your work when the battery LED is blinking orange, and plug in
the AC/DC adapter. The battery LED will change from blinking orange to orange
when the battery starts to charge (3 to 20 minutes before charging begins).

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page E - 34 for instructions on how to do this).

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.
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Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and pe-
ripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power
Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if con-
figured appropriately.

Figure E - 19 - Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you need to remove the battery for any reason,
see “Removing the Battery” on page 6 - 3.
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Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page E - 30
for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:

Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by
the AC/DC adapter.

Close modem or communication applications when they are not being used.

Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).

Disconnect any unnecessary external devices.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the bat-
tery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, espe-
cially any Alarms (unclick the tickboxes - see page E - 31) and Schemes (change
all the settings to Never - see page E - 25). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
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Driver Installation
This section covers driver and utility installation instruc-
tions for Windows XP Home & Professional (WinXP).
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM, click Install WinXP Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu and then follow the instructions to install
the driver. Alternatively click Start, navigate (Browse..)
to the executable file and then follow the manual setup
instructions.

Figure E - 20 - Drivers Installer Screen 1

1. Check the driver installation order from Table E-E - 
2 (all the drivers must be installed in this order) 
which is the same as that listed in the Drivers 
Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Figure E - 21 - Drivers Installer Screen 2

Note the Fingerprint
Utility will only appear
if you have included the
Fingerprint Reader
Module in your pur-
chase option (Models B
& C only). The Quick
Button Utility only ap-
pears if you DO NOT
have a PC Camera Mod-
ule installed (Models A &
B only).
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Installation Methods (Win XP)
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and
then browse to the executable file in the location listed in the table below and follow the installation procedure
for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.

Table E - 2 - Driver Installation

WinXP (SP2) Driver Page # Driver Location Note

 Chipset Page E - 38 X:\Drivers\Chipset\SETUP.EXE

Video Page E - 38 X:\Drivers\Video\setup.exe

Modem Page E - 38 X:\Drivers\Modem\ssetup.exe

Audio Page E - 39 X:\Drivers\Audio\SETUP.EXE

LAN Page E - 39 X:\Drivers\LAN\WinSetup.exe

CardReader Page E - 39 X:\Drivers\Cardreader\Setup.exe

TouchPad Page E - 39 X:\Drivers\Touchpad\setup.exe

Hotkey Utility Page E - 39 X:\Drivers\Hotkey\Setup.EXE

Quick Button Utility Page E - 39 X:\Drivers\QButton\3AP.exe Only appears if no PC Camera module is installed

Wireless LAN Page E - 40 X:\Drivers\WLAN\Setup.exe

Bluetooth Page E - 42 X:\Drivers\Bluetooth\Setup.exe

PC Camera Page E - 47 X:\Drivers\Camera\Driver\Setup.exe

Fingerprint Reader Page E - 53 X:\Drivers\Fingerprint\Application\x86\autorun.exe Only appears if a fingerprint reader module is installed
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Programs
item:
1. Click Start (menu), point to Settings and click Control 

Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or a
Windows XP version which includes Service Pack 2) be-
fore installing any drivers. Service Pack 2 includes sup-
port for USB 2.0.

If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:

1.Click Start (menu), point to Settings and click Con-
trol Panel (or click Control Panel).

2.Double-click System (icon); System (icon) is in Per-
formance and Maintenance (category).

3.Click the Hardware (tab) > Device Manager (button). 
4.Click “+” next to Other Devices (if its sub-items are

not shown).
5.Right-click Universal Serial Bus (USB) Controller

and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).

6.Restart the computer and it will find the USB 2.0 con-
troller.
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New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the driver
install procedure), click Cancel to close the window,
and follow the installation procedure as directed.

Service Pack Information
Make sure you install Windows XP Service Pack 2
(or a Windows XP version which includes Service
Pack 2) before installing any drivers.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Video 

VIA (Model A)
1. Click 2.Install Video Driver > Yes.
2. Click Finish.

NVIDIA (Models B & C)
1. Click 2.Install Video Driver > Yes.
2. Click Next (click Continue Anyway if asked if 

you want to continue at any time).
3. Click to select “Yes, I want to restart my com-

puter now”.
4. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.
4. Check if the modem country selection is appro-

priate for you (Control Panel > Phone and 
Modem Options).
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Audio
1. Click 4.Install Audio Driver > Yes.
2. Click Next > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 5.Install LAN Driver > Yes.
2. Click OK.
3. The network settings can now be configured.

CardReader
1. Click 6.Install CardReader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 7.Install TouchPad Driver > Yes.
2. Click Next > Next > Next (click Continue 

Anyway if asked if you want to continue at any 
time).

3. Click Finish to restart the computer.

Hot Key Utility (Model A & B Computers)
1. Click 8.Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Hot Key Utility (Model C Computers)
1. Click 8.Install Hotkey Utility > Yes.
2. Choose the language you prefer, and click OK.
3. Click Next.
4. Click Finish to restart the computer.

Quick Button Utility
If you do not have a PC Camera module installed,
then the Quick Button Utility will appear in the Driv-
ers Installer menu (only install the quick button
driver if the PC Camera is not installed). See
Table 1 - 2, on page 1 - 7 and “Application Quick
Buttons” on page E - 6 for details.

1. Click 11.Install Quick button Utility > Yes.
2. Click Next.
3. Click Finish to restart your computer.
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802.11 b/g USB WLAN Module
If you have included an 802.11b/g USB WLAN module in your purchase option, you
will have the appropriate software provided for your module.

Before installing the 802.11b/g USB WLAN driver, make sure that the Wireless
LAN module is on. Use the Fn + F11 key combination (see “Function Keys” on
page 1 - 12) to toggle power to the Wireless LAN module. Make sure you install
the drivers in the order indicated in Table E - 2, on page E - 36.

802.11 b/g WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click Install WinXP Drivers > 9.Install WLAN Driver > Yes.
3. Click Next.
4. Click Finish to complete the installation.
5. The operating system is the default setting for Wireless LAN control in Win-

dows XP (see overleaf).
6. Access any available wireless networks from Network Connections > 

Wireless Network Connection menu in Windows (or click the icon  in 
the taskbar), and click View Wireless Connections.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table , on
page 1 - 10/ Table 1 - 5, on
page 1 - 12).
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Network 
Connection

Use the Windows Net-
work Connections con-
trol panel to access
available wireless net-
works (Start > Settings >
Network Connections
or Start > Connect To >
Show all Connections).

Figure E - 22 
Wireless Network 

Control Panels
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Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth module
is on. Use the Fn + F12 key combination (see “Function Keys” on page 1 - 12) to
toggle power to the Bluetooth module. Make sure you install the drivers in the or-
der indicated in Table 4 - 1, on page 4 - 3.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install WinXP Drivers > 10.Install Bluetooth Driver > Yes.
3. Click Install Software Drivers v2.3.0.1.
4. Choose the language you prefer, and click OK.
5. Click Next.
6. Click the button to accept the license agreement, and then click Next.
7. Click Next > Next > Install.
8. Click Finish.
9. You can configure the settings at any time by going to the IVT Corporation 

BlueSoleil - Main Window control panel (Start > Programs/All Programs 
> IVT BlueSoleil), or by clicking the taskbar/desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table , on
page 1 - 9/ Table 1 - 5, on
page 1 - 12).
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User Guide

View the BlueSoleil User
Guides (Contents and In-
dex) from the Help menu
(or press the F1 key) in
the IVT Corporation
BlueSoleil - Main Win-
dow control panel. Click
BlueSoleil User Guides
in the Contents tab, and
click to select the appro-
priate User Guide from
the panel on the right.

Figure E - 23
Bluetooth Control 

Panel & User Guides
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection
in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > 
Network Connections OR Start > Connect To > Show all Connections) or by 
clicking the taskbar icon .

2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick in the “Show icon in the notification area when connected” 

box.
4. Close the control panels and the icon  for the Bluetooth connection will be 

displayed in the taskbar when connected (see sidebar and overleaf).

Disconnecting

In order to have the taskbar
icon display the correct
connection status, you will
need to exit the IVT Corpo-
ration BlueSoleil - Main
Window by clicking the File
menu and selecting Exit
(see over).

After exiting the program
you can then use the Fn +
F12 key combination to turn
off the Bluetooth module.

If you use the close button,
or turn off the Bluetooth
module (by using the Fn +
F12) the taskbar icon will
not display the correct sta-
tus 

Figure E - 24
Local Area 
Connection
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5. Use the Fn + F12 key combination to turn on the Bluetooth module.
6. Run the IVT Corporation BlueSoleil program from the desktop icon or Start menu.
7. The connection status will then be displayed.

Figure E - 25 - Bluetooth Connected
8. To disconnect click File from the IVT Corporation BlueSoleil - Main Window, and select Exit (the Local Area

Connection will then display “A network cable is unplugged”).
9. Do not use the close  button or Fn + F12 key combination before clicking File > Exit or the correct status will

not be displayed.
10. You can then use the Fn + F12 key combination to turn off the Bluetooth module (check the LED icon for the

Bluetooth module power status).

Figure E - 26 - Bluetooth Disconnected
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function Keys” on page 1 - 12) to
toggle power to the PC Camera module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3. 

Taking Still Pictures

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.

.Double-click the Bison-
Cam, NB Pro icon.

 

Click Take a new picture
in the Camera Tasks
box.

You can use the applica-
tion button  to take still
pictures if you have in-
stalled the hot key driver.
(See “PC Camera Hot
Key Buttons” on page E
- 52.)

Latest PC Camera Driver Information

Check the CD, and any accompanying insert pages for the latest updated information on
the PC Camera driver, that may override the information provided here.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the
Quick Button Utility Driver (entitled Multimedia Keyboard Driver)  before installing the PC
Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control
panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then unin-
stall the PC Camera Driver after removing the camera module. You can then insert the De-
vice Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button Utility
driver from the Drivers Installer menu.
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PC Camera Driver Installation
1. Make sure the module is powered on (click Cancel if you see a “New Hard-

ware Found” message), and then insert the Device Drivers & Utilities + 
User’s Manual CD-ROM into the CD/DVD drive.

2. Click Install WinXP Drivers > 11.Install Camera Driver > Yes.
3. Click Install Products.
4. Choose the language you prefer, and click OK.
5. Click Next > Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the 

desktop or from the BisonCam item in the Start > Programs/All Programs 
menu (if the hardware is turned off use the Fn + F10 key combination to 
turn it on again).

Model A & B Computers Only
7. You can use the application button  to run the BisonCap application if 

you have installed the hot key driver (see “Hot Key Utility (Model C Com-
puters)” on page 4 - 6).

8. A Snapshot folder will be placed on the desktop to record still pictures 
taken with using the application button  (see “PC Camera Hot Key But-
tons” on page E - 52).

Stand by/Hibernate 
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667). 

Download and install the
Hotfix to correct this er-
ror.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows (see Figure E - 27 on page E - 49).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select HD Audio rear input (for a microphone plugged in to the microphone-in jack)/HD Audio Front Mic (for 

the built-in microphone) from the Mixer device menu and click OK (make sure there is a tick in the Microphone 
tick box).

5. Click Recording (button) and click OK.
6. Boost the volume in the Microphone section as high as it will go (make sure there is a tick in the Select tick box 

if you have selected HD Audio rear input).
7. Close the open windows.
8. You can also boost the microphone from the Mixer in the VIA Audio Deck  menu (see page E - 9).
9. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu (or press 

the application button ).
10. Go to the Devices menu heading and select HD Audio rear input OR HD Audio front mic (it should have a 

tick alongside it).
11. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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Figure E - 27
Audio Setup 

(Windows XP)
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture pro-
cess - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page E - 48) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., 

choose a file name and location, and then click Open (you can view the file using 
the Windows Media Player).

Set Capture File
In the BisonCap application you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will au-
tomatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the BisonCap applica-
tion. You can choose to
ignore this by clicking
Cancel.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

You may find it helpful to
defragment the HDD be-
fore capture.
E - 50 PC Camera Module



Windows XP Information

E

Eliminating Screen Flicker
If you find that the video screen in the BisonCap application is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure E - 28
Video Capture Filter
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PC Camera Hot Key Buttons
(Model A & B Computers)
You can use the PC Camera hot key buttons (the quick button utility must not be in-
stalled - see “Quick Button Utility” on page E - 39)    to run the BisonCap
program, to take still pictures and to zoom the camera in and out (if you have installed
the hot key and PC Camera drivers - see “Hot Key Utility (Model C Computers)” on
page E - 39 & “PC Camera Driver Installation” on page E - 47).

1. Make sure the PC Camera is on (use the Fn + F10 key combination to power on the 
camera).

2. Press the  application button once.
3. The BisonCap application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the  application button for a second time (you will hear a camera motor 

sound to indicate the picture is being taken).
6. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture
using the application hot
key button.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure E - 29
Snapshot Folder
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Fingerprint Reader
(Optional for Model B & C Computers)
If you have included the fingerprint reader in your purchase option (for Model B and
C computers only) you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-
tector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM into the 

CD/DVD drive.
2. Click Install WinXP Drivers > 12.Install Fingerprint Utility > Yes.
3. Click Software Installation.
4. Click Next > Next > Next.
5. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
CD-ROM and click Install
WinXP Drivers (button).
Click Unlock (button) and
then click 12.Install Fin-
gerprint Utility > Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual CD-ROM and click
User’s Manual (button),
and click Install Acrobat
Reader (button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, or double click the taskbar 

icon .
2. On the first run of the program you will be asked to click the button to accept the license, and then click OK.
3. Click Next and select “Enrollment to the hard disk”, and click Finish.
4. Click Next and you will then be prompted to enter your Windows password (note: If you have not set a 

password Protector Suite QL cannot secure access to your computer).
5. Click Next > Next (tick the “Run interactive tutorial” tickbox to run through the Fingerprint Tutorial).
6. Click Next for each window of the tutorial (you can click the button to “skip tutorial” at any time).
7. Click the button above any of the fingers to begin the enrollment process for that finger.
8. Swipe the finger three times to enroll that finger.
9. Repeat the process for all the fingers you wish to enroll (see below), and then click Next.

Figure E - 30 - Fingerprint Enrollment

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 
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10. Click Finish > Close.
11. Right-click the taskbar icon  to bring up the menu that allows you to Edit Fingerprints, start Control Center, 

access the Help menu etc. You can also run the Control Center etc. from the Protector Suite QL item in the 
Programs/All Programs menu.

12. See “Help & Manual” on page E - 53 for further details.
13. If you swipe your finger over the reader at any time you can access the Biomenu to lock the computer, 

register websites, open the Control Center and access the Help menu.

Figure E - 31 - Control Center & Biomenu
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